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Waking up the system
To make a call you need to wake up the system from standby. However, if someone
calls you, the system will wake up by itself.

After wake-up, the screen will typically look like this:

• To wake up the system just pick up the TRC5 remote control or press any key. You
may have to point the remote control towards the system to make sure it discovers
you.

The dial-in address or dial-in number of your system
is displayed in the upper left corner.

Date and time of day.

norah.dollhouse@somecompany.com

Sept

20

• The system will now display the wallpaper.
• The dial-in address or dial-in number of your system is displayed in the upper left
corner. If you have questions about the dial-in address or number, contact your
system administrator.
• The screen will also indicate if there are any calls you have missed.

Softkeys (described on the following pages).

.

If the system fails to respond to the remote control or to incoming calls, make sure that:
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•

The system is connected to line voltage.

•

The remote control has working batteries.

•

The internal cables, such as the monitor cable and/or the camera cables are properly
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The TRC5 remote control
The Function keys in the upper part of the remote
control reflect the softkeys on screen.

RECENT CALLS
alice.wonderland@company.co.nla
Received 20.09.10 16.29

hedda.gabler@somecompany.org
Placed 20.09.10 15.10

dorian.grey@myself.net
Missed 20.09.10 14.55

frodo,b.aggins@myshire.org
Received 20.09.10 12.20

floria.tosca@somecompany.org
Placed 20.09.10 08.17

HOME
Call

Call

Presentation
Phone book

The middle part of the remote control is used to handle
video, sound, phone book, menus and navigation.

Camera control
Recent calls
Settings Add another participant

Recent calls

Missed calls

Placed calls

Received calls

The lower part of the remote control is similar to the
keypad of a mobile phone.
FUNCTION KEYS: Each key
corresponds to a soft key on
the screen and represents
shortcuts and advanced
functions.

MICROPHONE: Press this key to
switch between setting the
microphone to on and to off.

VOLUME: Press the + or
the – on this key to adjust the
volume. Press – to mute an
incoming call.

PRESENTATION: Press this key to
show or hide a presentation.

ARROW UP/DOWN: Use the and Arrow keys to navigate in the menu and to move the
camera (pan, tilt) when the menu on screen is not displayed.

ZOOM: Press
the + or – on this key
to zoom the camera
in and out.

ARROW LEFT: Press the
Arrow key to go one
step back in the menu or
to move to the left in a text
field.

ARROW RIGHT: Press the
Arrow key to expand
the selected menu item or
to move to the right in a
text field.

OK/SELECT: Press the center key to confirm your choice or selection.
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Alphanumeric keypad: Use the keypad in the same way as you would use a mobile phone.

PHONE BOOK: Press
this key to display the
phone book.

LAYOUT: Press this key
to display the Layout
menu, then select a
view in the menu.

HOME: Press this key
to go back to the Home
menu.

0-9, a-z, period (.), @,
space, *: Press a key
repeatedly to go through
the options displayed on
each key.

CLEAR: Press the key to
remove characters in a text
field.

abc/123 #: Press and hold
the # key to toggle between
characters and numbers.

CALL: Press this key to
place a call.
Press this key to accept
an incoming call.

END CALL   / STANDBY: Press
this key
to reject an incoming call, to
end an ongoing call
or—when idle—to go
into standby mode.
When navigating in the menus
the key is used to exit the
menu system.
Press and hold this key to
have the system enter standby
mode.
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Navigating in the menus
• In an input field, pressing C will delete characters/numbers to the left of the cursor
position.

Use the remote control to operate your video system. A few basic navigation
principles are all you need to know to get started.
• Press the Home key ( ) to show the Home menu or wake up the system by lifting
the remote control.

• When the system shows the Home menu only (see the Fig. below), pressing Home
key ( ) will hide the menu. To bring it back, press the Home key ( ) again.

• The Arrow keys in the center of the upper part of the remote control are used to
navigate in the menus.

• In an input field, pressing C will delete characters/numbers to the left of the cursor
position.

• When the system shows the Home menu only (see the Fig. below), pressing Home
key ( ) will hide the menu. To bring it back, press the Home key ( ) again.

Press the

key to display the Home menu on the screen.
Sept

20

HOME

The element currently
selected is indicated by an
orange rectangle.

Call

Use the and Arrow
keys to navigate up and
down in a menu.

Presentation

The little triangle
indicates that
a submenu is
available.
RECENT CALLS
alice.wonderland@company.co.nla
Received 20.09.10 16.29

hedda.gabler@somecompany.org

Camera control

Placed 20.09.10 15.10

dorian.grey@myself.net
Missed 20.09.10 14.55

frodo,b.aggins@myshire.org
Received 20.09.10 12.20

floria.tosca@somecompany.org
Placed 20.09.10 08.17

Settings

HOME
Call

Call

Presentation
Phone book
Camera control
Recent calls
Settings Add another participant

Example showing a submenu displayed by pressing the right arrow key.
HOME

HOME
Call

Recent calls

Call
a

Context sensitive softbuttons
corresponding to the function
keys of the
remote control.

abc

Presentation

alice.wonderland@everywhere.co.nl
Presentation
norah.dollhouse@somecompany.com

Camera control

Camera control
Dorian Grey
Hedda Gabler
Settings
Floria Tosca

Use the Arrow key key to collapse the
menu expansion (to go back one level).

Placed calls

Received calls

CALL

Recent calls

Settings

Missed calls

My contacts

Softbuttons not used in a
given context are shown
ghosted (grey).

Phone book

Use the Home key ( ) to exit all menus
and return to showing the Home menu
only.

D14852.01 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, July 2011.

All contents are copyright © 2010–2011 Cisco Systems, Inc. All rights reserved.

7

www.cisco.com

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20
Contents

Getting
Getting started
started

Making calls

Phone book usage

In-call features

User guide
Advanced settings

Contact us

Entering text in text fields
• Press Function key number two from the left to invoke the virtual keyboard if it
does not appear by itself.

Some menu fields expect text information to be entered. This is used to enter the
number or the identity of the person you want to call (the URI) as well as for such
things as to search in the phone book and to maintain your list of contacts (the My
contacts).

• Use the

Arrow key to move the cursor inside the keyboard.

• Use the Arrow keys to move about the keyboard.
• When the required key is reached, press
entry field.

The following applies

to have the letter or digit inserted in the

• If you navigate to the alpha/numeric selection field, pressing will take you to
numeric from alpha and vice versa. Navigate and select inside here to the extent
needed. The same principle applies if you need to enter special characters.

• If you press a number key when you are not in a call, the Call menu will be shown.
• The system will automatically switch to text mode (abc) inside entry fields expecting
text entries. The easiest and most convenient way of entering letters is by invoking
the on-screen virtual keyboard. Do as shown below to invoke the keyboard.

• Once entered, either navigate to one of the context sensitive fields and use that or
just press the Function key to hide the keyboard. In both cases this will put your
entry into effect.

• You may also use the keypad in the same manner as when composing text
messages on a mobile phone, but the virtual keypad is by far more convenient and
faster to use.

Virtual keyboard details

Invoking the virtual keyboard

CALL

Enter contact...HOME
Call

CALL

123

Enter contact...HOME

Call

Presentation
Phone book

Call

Camera control
Recent calls

Presentation
Phone book

Settings Add another participant
abc / 123

Turn keyboard on

123

Call

Camera control
Recent calls
Settings Add another participant
abc / 123

Press as shown to produce
the virtual keyboard.

Navigate to here
and click to switch
between letters and
digits.

Navigate to here
and click to
access special
characters.

Turn keyboard off

Press again to hide
the virtual keyboard.
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Screen layout
Layout control
The layout of the screen can be changed as shown to the right.
To show the display options screen, press the Layout (
may get to it through Settings > Layout.

) key. Alternatively, you

Layout control outside a
call is limited to the choice
between showing selfview
and showing a wallpaper...

SETTINGS
Layout

• Use the Arrow keys to move between the alternatives and use
alternative you want to use.

Main source: Camera

to select the

Call settings
Language: English

• You may—or may not—include selfview (to show the outgoing video signal from
your own system). This will show you what others will see from your system.

Date and time

LAYOUT CONTROL
Wallpaper: Growing
Presentation
System information
Show selfview

Camera control
Advanced

Wallpaper

Tip: Adding a wallpaper to your screen
In the Home menu, navigate
down to Settings and press the
key.

SETTINGS

Call settings

Call

Language: English

Presentation

Date and time

Camera control
Settings

Call settings

Date and time

LAYOUT CONTROL

HOME

Hide selfview
Sounds and alerts
Call

Wallpaper: Growing
Presentation
System information Wallpaper with selfview
Camera control
Advanced

Full screen selfview

Settings
Restart

SETTINGS
Layout
Main source: Camera

HOME

Main source: Camera

Language: English

However, if you
already have
activated the
selfview, the menu
will give you these
options when you
enter the menu
again.

HOME

Sounds and alerts
Call

Settings
Restart

SETTINGS
Layout

HOME

Layout

In the Settings
submenu navigate
down to Wallpaper.
Press
again.

Main source: Camera
Call settings
Language: English

Layout control when in a
call provides the choice
of showing selfview or full
screen participant...

HOME

EndDate
call and time

CallSounds and alerts

CallSounds and alerts

Wallpaper: Growing
Presentation

LAYOUT CONTROL

Presentation
Wallpaper: Growing
Show selfview
System
information
Camera
control

System information
Camera control
Administrator settings
Settings
Restart

Advanced
Settings
Restart

Full screen participant

SETTINGS

However, if you
already have
activated the
selfview, you may
select where the
selfview should
appear in the image
when you enter the
menu again.

SETTINGS
Layout
Main source: Camera
Call settings
Language: English
EndDate
call and time

HOME
LAYOUT CONTROL

Sounds and alerts
Show selfview
Call
Wallpaper: Growing
Presentation
System information Speaker participant
Camera control
Advanced

Restart
Settings

Full screen participant

Layout
Main source: Camera

Change remote layout (the outgoing video) when hosting
MultiSite Conference...

Call settings
Language: English

Select between the options
available and press the
key to leave the menu
putting your choice into
effect. See also page
21 for more on this.

Date and time

HOME

Sounds and alerts
Call
Wallpaper: Growing
Presentation
System information

LAYOUT CONTROL

None

Show selfview

Growing

Camera control
Administrator settings

Summersky

Settings
Restart

Custom

Speaker participant

Full screen participant

Remote layout
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Camera presets
Using the presets
You may create predefined settings of where the camera points and the zoom. This
is referred to as camera presets. See the next page for more.
CAMERA PRESETS

HOME
Call

Pos. 1

Presentation

Pos. 2

Camera control

Pos. 3

Settings

Edit camera preset

Camera presets must have been defined before
you do this.
Press the
key on the remote control to display
the Home menu and select Camera control. Use
the and Arrow keys to navigate in the menu.
Use to select a preset. The camera will now
move accordingly. Note that this feature may be
used any time.

Where to find camera presets

Sept

20

Camera presets

Camera settings

Main source

Exit

Camera presets must have been defined
before you do this.
Press the
key on the remote control to
display the Home menu and select Camera
control. Use the 0~9 keys to select a preset.
The camera will now move accordingly. Note
that this feature may be used any time.
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Adding a new camera preset (I)

LAYOUT CONTROL

HOME

Show selfview

Call
Presentation

Wallpaper
Camera control
Settings

Outside a call, press the
Layout key and select Show
selfview followed by the
key, if needed. You will now
see the outgoing video from
your system.

Press the key to display
the Main menu and
navigate to
Camera control.

Adjust pan, tilt and
zoom, as required.

Press the

This will will display the softkeys along the bottom of
the screen, as shown.

key.

SET CAMERA PRESETS

Default
Zoom out
Whiteboard

CAMERA PRESETS
Camera presets

Camera settings

Main source

Exit

CAMERA PRESETS

Pos. 2

Default

Pos. 2

Zoom out

Pos. 3

Whiteboard

Not defined
Not defined
Not defined
Not defined

Edit camera preset

Display the Camera presets
menu by pressing the Function
key corresponding to the
Camera presets softkey on
the remote control to open the
menu.
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Edit camera preset

Not defined
Not defined

Navigate to the undefined
preset you would like to define.
When you have located it,
press the key.
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Adding a new camera preset (II)

The virtual
keyboard will now
automatically be
invoked by the
system.

4:NEW PRESET

EDIT CAMERA PRESETS

Default
Zoom out
Whiteboard

Name

abc

4:NEW PRESET
Name

abc

4:NEW PRESET

charl

Name

Save new preset

Save new preset

Save new preset

Cancel

Cancel

Cancel

abc

Not defined

CAMERA PRESETS

Not defined

Default

Not defined

Zoom out

Not defined
Whiteboard

Not defined

Edit camera preset

Not defined

Use the
Arrow key
as shown to move
the cursor up into
the virtual keyboard
(indicated by an orange
square).

Give the new preset a
descriptive name.
Use the Arrow keys to
move about the keyboard
and the key to select a
character.
Access special characters
and numerics by means of
the corresponding keys.

abc

SET CAMERA PRESETS

4:NEW PRESET
Name

charlie watts

Save new preset

Press the key to put your
changes into effect. This
will be confirmed by the
system.

Default
Zoom out
Whiteboard
charlie watts
Not defined
Not defined

Cancel

Not defined
Not defined
Not defined

Arrow key
Pres the
a sufficient number of
times to move the cursor
down to Save new
preset, as shown.
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Editing an existing camera preset (I)

LAYOUT CONTROL

HOME

Show selfview

Call
Presentation

Wallpaper
Camera control
Settings

Outside a call, press the
Layout key and select Show
selfview followed by the
key, if needed. You will now
see the outgoing video from
your system.

Press the key to display
the Main menu and
navigate to
Camera control.

Adjust pan, tilt and
zoom, as required.

Press the

This will will display the softkeys along the bottom of
the screen, as shown.

key.

SET CAMERA PRESETS

Default
Zoom out
Whiteboard

CAMERA PRESETS
Camera presets

Camera settings

Main source

Exit

CAMERA PRESETS

Pos. 2

Default

Pos. 2

Zoom out

Pos. 3

Whiteboard

Not defined
Not defined
Not defined
Not defined

Edit camera preset

Display the Camera presets
menu by pressing the Function
key corresponding to the
Camera presets softkey on
the remote control to open the
menu.
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Edit camera preset

Not defined
Not defined

Navigate to the existing preset
that you would like to redefine.
When you have located it,
press the key.
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Editing an existing camera preset (II)

3:WHITEBOARD

EDIT CAMERA PRESETS

Default

Update to current camera position

Zoom out
Whiteboard
CAMERA PRESETS
Default
Zoom out

Not defined

Delete preset
Cancel

Not defined

Press the key to put your
changes into effect. This
will be confirmed by the
system.

Not defined
Not defined

Whiteboard
Edit camera preset

Not defined
Not defined

Navigate to:
• Update to current camera position to
redefine the preset
• Delete preset to remove it from the list
• Cancel to prepare to leave the menu
undoing any updates.

D14852.01 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, July 2011.

All contents are copyright © 2010–2011 Cisco Systems, Inc. All rights reserved.

14

www.cisco.com

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20
Contents

Getting
Getting started
started

Making calls

Phone book usage

User guide

In-call features

Advanced settings

Contact us

Camera settings
Camera settings let you adjust the exposure and whitebalance.

2. Press the

Do as follows:

3. This will cause softbuttons to appear. Press the Function key corresponding to
Camera settings (Function key number 2 from the left).

1. Press the
key on the remote control to display the Layout menu. Select Selfview
to be shown as required.

key to display the Home menu and select Camera control.

4. Follow the procedures outlined below.

Adjusting the exposure of the camera

Adjusting the whitebalance of the camera

CAMERA SETTINGS

Exposure

CAMERA SETTINGS

Exposure

Whitebalance

Whitebalance

EXPOSURE
Brightness mode: Auto
Brightness level: 1
Backlight: Off

If you change the Brightness
mode to Manual, the
Brightness level becomes
possible for you to set. Since
Auto has been chosen here,
the actual level is shown
ghosted.

WHITEBALANCE
Whitebalance mode: Manual
Whitebalance level: 1

Since the whitebalance has been set to Manual in this case, you will have access to
setting the whitebalance in the usual manner. Use Automatic if that is more convenient.

Backlight compensates for any backlight shining on
the camera from behind you. Such light conditions
will tend to make you appear darker than needed.
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Main source

Call settings—an overview

You may choose what to use as the main input source. This will typically be the
camera, a secondary camera (if applicable), the PC input or other sources such as a
DVD player.

Use the Call settings menu to set the default bit rate and how the system shall answer
incoming calls. Answering can be set to automatic or to manual. More on this can be
found on the next page.

Do as follows:

Do as follows:

1. In the menu select Settings > Main source and expand the submenu.

1. In the menu select Settings > Call settings and expand the submenu.

2. Use the Arrow keys to move between the alternatives and use
alternative you want to use.

2. Use the Arrow keys to move between the alternatives and use
alternative you want to use.

3. Collapse the menu using the

to select the

Arrow key.

3. Collapse the menu using the

Main source settings

Arrow key.

The call settings options

HOME

HOME

Call

Call

Presentation

SETTINGS

Presentation

SETTINGS

Camera control
Settings

to select the

Camera control

Layout

Settings

Language: English

Camera

Language: English

PC

Date and time
Sounds and alerts

Date and time

Wallpaper: Growing

Sounds and alerts
Wallpaper: Growing
System information
Administrator settings
Restart

Main source: Camera
Call settings

Main source: Camera
Call settings

Layout

This example has been
taken from a Codec C20
equipped Profile. Larger
systems may have more
options.

System information
Administrator settings

CALL SETTINGS

Auto answer mode: On
Auto answer delay: 5 sec
Auto answer mute: Off
Do not disturb mode: Off
Default callrate: 4000 kbps

Restart

More on Profile systems
and their codecs can be
found on
page 32.
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Call settings—auto answer options

Call settings—default call rate

You may set up your system to answer automatically whenever someone calls you.
If you choose to do so, you may also specify how long time it shall take before your
system connects you.

The Call settings menu lets you set the default call rate expressed as default number
of kilobits per second.
You may want to consult your system administrator to discuss the best setting in your
environment.

For privacy reasons you may want your microphone to be muted (turned off) when the
system answers automatically. Alternatively, you may set the system to Do not disturb.

The options in detail

The default call rate options

CALL SETTINGS

Auto answer mode: On

On

Auto answer delay: 5 sec
Off

Set to On to have your
system answer incoming
calls automatically and Off to
answer them manually.

SETTINGS

128

Layout

256

Do not disturb mode: Off

Main source: Camera

384

Default callrate: 4000 kbps

Call settings

512

Auto answer mute: Off

Language: English
CALL SETTINGS

HOME
Date and time
Auto answer mode: On
Sounds and alerts
Call
Auto answer delay: 5 sec
Wallpaper: Growing
Presentation
Auto answer mute: Off
System information

Use the and Arrow keys
to alter how long time it shall
take before your system
connects you. Interval is 0–50
seconds.

Auto answer mode: On
Auto answer delay: 5 sec
Auto answer mute: Off
Do not disturb mode: Off
Default callrate: 4000 kbps

CALL SETTINGS

768
1152
1472
1920
2560

Camera
Docontrol
not disturb mode: Off
Advanced

3072

Default callrate: 4000 kbps
Settings
Restart

4000

CALL SETTINGS

Auto answer mode: On
Auto answer delay: 5 sec
Auto answer mute: Off

On

Do not disturb mode: Off

Off

Default callrate: 4000 kbps

CALL SETTINGS

Auto answer mode: On
Auto answer delay: 5 sec
Auto answer mute: Off
Do not disturb mode: Off
Default callrate: 4000 kbps

On
Off

Scroll with the and Arrow
keys to access settings not
shown.

For privacy you may set the
microphone to be muted upon
autoanswer. You will then have to
activate the microphone yourself
(press ).

Options are 128, 256, 384, 512, 768 (initial default), 1152, 1472, 1920,
2560, 3072, 4000 and 6000 bits (not shown in Fig.) per second.

To further enhance your privacy
you may set the system to Do
not disturb. Your system will then
not respond to incoming calls. As
soon as you disable the Do not
disturb any call attempts made
while the feature was enabled
will be listed as missed calls.
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Language settings

About the setting of date and time

This will allow you to specify the language used in the menus and settings shown. The
following languages are supported: English, Norwegian, Swedish, German, French,
Italian, Japanese, Russian, Spanish, Korean, Finnish, Chinese (Simplified), Turkish,
Polish, Hungarian, Czech.

You may have the system pick date and time for you or you may specify date and time
zone settings along with date and time format and the date and time of day itself.
Do as follows:
1. Start from the Home menu and navigate down to Settings and press the key.
Then navigate to Date and time and press the key. Select between NTP mode Off,
Auto and Manual.

Do as follows:
1. Start from the Home menu and navigate down to Settings and press the
2. Then navigate to Language and press the
to select.

key again. Use the

and

key.

Arrow keys

Off: NTP mode is disabled—you will then have to specify date and time
Auto: The system locates the NTP server itself

3. Press the key to exit the menu putting changes into effect or the
Arrow key to leave the menu going one step back.

Manual: You must specify the path to the NTP server.
2. Press the key to exit the menu putting changes into effect or the
Arrow key to leave the menu going one step back.
Further details are shown on the next page.

Language settings options

Date and time settings overview
SETTINGS
Layout

Main source: Camera

French

Call settings

Call settings

German

Language: English

Italian
HOME

Japanese

Sounds and alerts
Call

Korean

Wallpaper: Growing
Presentation
System information

Norwegian

Camera control
Administrator settings
Settings
Restart

Layout

English

Main source: Camera

Date and time

SETTINGS

Chinese

Scroll with the
and Arrow
keys to access
languages not
shown.

Language: English
DATE AND TIME

HOME
Date and time
NTP mode: Auto
Sounds and alerts
Call
NTP server: 2.ntp.somewhere.cu.no
Wallpaper: Growing
Presentation
Time information
zone: GMT–12:00 (International
System

Portuguese

Manual

Settings
Restart
Time format: 24 hours

Spanish

All contents are copyright © 2010–2011 Cisco Systems, Inc. All rights reserved.
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Camera control
Date format: Day, Month, Year
Advanced
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Setting date and time yourself

Setting date and time automatically

You may specify date and time zone settings along with date and time format and the
date and time of day itself.

You may have the date and time of day set automatically. If you set NTP server to
Auto, the system will take care of the connection to the NTP server itself.

Do as follows:

If you set it to Manual, you must specify the path to the NTP server.

1. Start from the Home menu and navigate down to Settings and press the
Then navigate to Date and time and press the key.
2. Use Arrow keys and the

key.

At any rate, you must still specify time and date formats as well as the time zone.

key to set everything as required.

Deactivated NTP server

Activated NTP server
Scroll with the
and Arrow keys
to access settings
not shown.

CALL SETTINGS

NTP server: Off
NTP server: 2.ntp.somewhere.cu.no

10

International Date Line West

GMT-11:00
Midway Island, Samoa

GMT-10:00
Hawaii

GMT-09:00

Day: 10
Month: September

TIME ZONES

GMT-12:00

Alaska

GMT-08:00

February

Pacific time

GMT-07:00
Arizona

DATE AND TIME

Year: 2010

Mountain Time

NTP server: Auto

2010

GMT-07:00
Chihuahua, La Paz, Mazattan

Time: 13:37
Date format: Day, Month, Year

GMT-07:00

13:37

Time format: 24 hours

NTP server: 2.ntp.somewhere.cu.no

GMT-06:00

Time zone: GMT–11:00 (Midway Island

GMT-06:00

Central America

Saskatchewan

GMT-06:00

Date format: Day, Month, Year

Guadalajara, Mexico City, Monterrey

Time format: 24 hours

Year.Month.Day (yyyy.mm.dd)

Year.Month.Day (yyyy.mm.dd)
Month.Day.Year (mm.dd.yyyy)

Month.Day.Year (mm.dd.yyyy)

The options shown here are
available when NTP server Off has
been chosen only.

Day.Month.Year (dd.mm.yyyy)

Day.Month.Year (dd.mm.yyyy)
24 hours
12 hours (am/pm)

24 hours

DATE AND TIME

12 hours (am/pm)

NTP server: Manual

2.ntp.somewhere.cu.no

NTP server: 2.ntp.somewhere.cu.no

Save

Time zone: GMT–11:00 (Midway Island

Cancel

Date format: Day, Month, Year

Setting NTP server to Manual
lets you specify the path to
the NTP server. Otherwise
nothing is different from the
Auto setting.

Time format: 24 hours
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Setting ring tone volume

The system lets you choose between a multitude of ring tones.

The system lets you set the ring tone volume.

Do as follows:

Contact us

Do as follows:

1. Start from the Home menu and navigate down to Settings and press the

key.

1. Start from the Home menu and navigate down to Settings and press the

2. Then navigate to Sounds and alerts and press the key. Navigate to Ring tone and
press the key. Use the and Arrow keys to move among the ring tones. Each
ring tone will be played when you position the cursor at it.

2. Then navigate to Sounds and alerts and press the key. Navigate to Ring tone
volume and press the key. Use the and Arrow keys to set the volume.
3. Press the key to exit the menu putting changes into effect or the
Arrow key to leave the menu going one step back.

3. Press the key to exit the menu putting changes into effect or the
Arrow key to leave the menu going one step back.

Ring tone selection

Ring tone volume settings

SETTINGS
Layout

Layout
Main source: Camera

IceCrystals

Call settings

Call settings

Polaris

Language: English

Language: English

Alert
HOME

Sounds and alerts
Call
Wallpaper: Growing SOUNDS AND ALERTS
Presentation
Ring tone: Marbles
System information
Camera
control
Ring
tone volume: 40
Advanced

Key tone: On
Settings
Restart

SETTINGS
Marbles

Main source: Camera

Date and time

key.

Date and time

Discreet

Sounds and alerts
Call

Fantasy

Wallpaper: Growing SOUNDS AND ALERTS
Presentation
Ring tone: Marbles
System information

Jazz
Nordic

Camera
control
Ring
tone volume: 40
Advanced

Echo

Key tone: On
Settings
Restart

Rhythmic
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Setting key tone to on or off

Setting wallpaper on your screen

The system may be set to emit a sound when you press a key on the remote control
inside the dialing dialog menu.

The system lets you set a wall paper on your screen. This is shown in idle condition
only.

Do as follows:

Do as follows:

1. Start from the Home menu and navigate down to Settings and press the

key.

1. Start from the Home menu and navigate down to Settings and press the

key.

2. Then navigate to Sounds and alerts and press the key. Navigate to Key tone and
press the key. Use the and Arrow keys to select.

2. Then navigate to Wallpaper and press the key. Use the and Arrow keys to
select wall paper. Uploading and inserting a custom wallpaper is explained overleaf.

3. Press the key to exit the menu putting changes into effect or the
leave the menu going one step back.

3. Press the key to exit the menu putting changes into effect or the
leave the menu going one step back.

Arrow key to

Keytone setting

Wallpaper setting options

SETTINGS

SETTINGS

Layout

Layout

Main source: Camera

Main source: Camera

Call settings

Call settings

Language: English

Language: English

Date and time

HOME

Date and time

Sounds and alerts
Call

Sounds and alerts
Call

Wallpaper: Growing SOUNDS AND ALERTS
Presentation
Ring tone: Marbles
System information

Wallpaper: Growing
Presentation
System information

Camera
control
Ring
tone volume: 40
Advanced

Key tone: On
Settings
Restart

Arrow key to

On
Off
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System information

The system lets you upload and use your own wallpaper (for example your logo) on
your screen. This custom wallpaper picture can be any size up to 1920×1200 pixels.

System information can be listed.

User guide
Advanced settings

Contact us

Do as follows:

The custom wallpaper is uploaded by means of the system’s web interface. See the
Appendices section of the Administrator Guide for your system for further details
about the web interface.

1. Start from the Home menu and navigate down to Settings and press the
2. Then navigate to System information and press the
3. To exit this screen, press the Home key (

Do as follows:

key.

key again.

).

1. Open a web browser and enter the IP address of the codec/endpoint of your
system.
2. Select Wallpaper from the menu bar on the left side of the screen.
3. Browse for the file and click the Upload button.
4. Close the web browser.
5. Select Custom wallpaper (see the previous page) to put the change into effect.
A shortcut to this function is available. Make sure the system displays the Home
menu (press the key on the remote control to display this menu). Then press the
rightmost softbutton to display the System information.

Note that access to the system’s web interface may have been password protected
by your administrator.
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Entering the Advanced configuration

Restarting the system

Your video system has a separate set of Advanced configuration settings intended
to be used by system administrators only. These settings may be protected by a
password.

Some changes in the system settings, network settings and the infrastructure
configurations may call for a system restart.
Do as follows:

Aspects of the Administrator settings are discussed in more detail in the section
“Advanced settings” on page 41.

1. Start from the Home menu and navigate down to Settings and press the
2. Then navigate to Restart and press the

A full presentation of the Administrator settings can be found in the Administrator
Guide for your system, available separately for download from Cisco.com.

3. Use Arrow keys and the

Advanced configuration entering

key to make your selection.

Restarting
SETTINGS

SETTINGS

SETTINGS

Layout

Layout

Layout

Main source: Camera

Main source: Camera

Main source: Camera

Call settings

Call settings

Call settings

Language: English

Language: English

Language: English

Date and time

HOME

Sounds and alerts
Call
Wallpaper: Growing
Presentation
System information
Camera control
Administrator settings
Settings
Restart

key.

key.

Date and time

HOME

Date and time

PASSWORD
Sounds ADMINISTRATOR
and alerts
Call
Please enter your
Wallpaper: Growing
Administrator password:
Presentation

HOME

Sounds and alerts
Call
Wallpaper: Growing
Presentation
System information

System
*** information
Camera control
Advanced
OK
Settings
Restart
Cancel

Camera control
Administrator settings
Settings
Restart

Restart
Do you really want to restart the system?
Restart
Cancel
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Chapter 2

Making calls
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Placing calls by specifying the number or URI

HOME
CALL

CALL

Call

Enter contact...

Presentation

Enter contact...

abc

Call

Camera control
Settings

Press the key to display
the Main menu.

abc

Call

Phone book

Phone book

Recent calls

Recent calls

Add another participant

Add another participant

Press the key to invoke
the virtual keyboard.

Use the Arrow key, as shown, to
move the cursor up into the virtual
keyboard (indicated by an orange
square).

CALL
HOME
Call
a

HOME

CALL

Call
a

abc

Hedda Gabler
abc

Call

Call

Recent calls

Recent calls

alice.wonderland@everywhere.co.nl
Presentation
norah.dollhouse@somecompany.com

alice.wonderland@everywhere.co.nl
Presentation
norah.dollhouse@somecompany.com

Presentation
Phone book

My contacts

Camera control
Recent calls

Camera control
Dorian Grey
Hedda Gabler
Settings
Floria Tosca

My contacts

Camera control
Dorian Grey
Hedda Gabler
Settings
Floria Tosca

Phone book

Use the Arrow keys to move about the
keyboard and the key to select a character.
Access special characters and numerics by
means of the corresponding keys.
Matches will appear as you write.
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Placing calls using the phone book

PHONE BOOK

PHONE BOOK

Search

PHONE BOOK

Search

Search

a

My contacts

My contacts

Abraham Anderson

0.1 - Beijing Office

0.1 - Beijing Office

Adrian Jones

0.2 - London Office

0.2 - London Office

Harry P. Otter

0.3 - New York Office

0.3 - New York Office

Hedda Gabler

0.4 - Oslo Office

0.4 - Oslo Office

Norah Dollhouse

0.5 - San Jose Office

0.5 - San Jose Office

Peer A. Gynt

0.5 - Washington Office

0.5 - Washington Office

Roberta Nielsen

Press the key to display the Phone book.
This will also invoke the virtual keyboard.
Your phone book may contain folders, as
outlined.

Use the Arrow key, as shown, to
move the cursor up into the virtual
keyboard (indicated by an orange
square).

Any search you make will include current
folder and any subfolders, so if you stay at
the top level (sometimes referred to as the
root level), your search wil be made within
all (sub)folders.

Access special characters
and numerics by means of the
corresponding keys.
Matches will appear as you write,
as outlined.

PHONE BOOK
Search

Use the Arrow keys to move about
the keyboard and the key to
select a character.

Harry P. Otter

harry.p.otter@somecompany.com

a

Abraham Anderson

Call

Adrian Jones
Harry P. Otter

Edit before call

Hedda Gabler
Norah Dollhouse

Save to my contacts

Peer A. Gynt

Add to participants list

Roberta Nielsen

View dialing method

Navigate down to the entry to be called
and press the key or the Arrow key to
produce the options available.

Call the entry selected (press

or the

key).

Edit the entry (for example insert a prefix)
and then call.
Save the entry to your
personal list of contacts.
Add to list of participants in a multisite call
(optional feature).
View dialing method options
(H.323 and SIP wherever applicable).

More about the phone book can be found in the section “Phone book usage”—click on the topic on the menu line at the top of this page.
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Placing calls by means of the Recent calls list

RECENT CALLS

HOME
CALL

harry.p.otter@somecompany.com
Received 20.06.11 16.29

hedda.gabler@somecompany.org

Call

Placed 20.06.11 15.10

dorian.grey@myself.net

Presentation

Missed 20.06.11 14.55

frodo,b.aggins@myshire.org

Call

Camera control

Received 20.06.11 12.20

floria.tosca@somecompany.org
Placed 20.06.11 08.17

Phone book

Settings

Recent calls
Add another participant

Press the key to display
the Main menu.

Harry P. Otter

harry.p.otter@somecompany.com

Call
Edit before call
Save to my contacts
Add to participants list
View dialing method

Navigate down to Recent calls
and then press the key.

Call the entry selected (press

or the

Use the Arrow keys to navigate in
the list.

key).

Edit the entry (for example insert a prefix)
and then call.
Save the entry to your
personal list of contacts.
Add to list of participants in a multisite call
(optional feature).
View dialing method options
(H.323 and SIP wherever applicable).
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Terminating an ongoing call

When someone is calling you

key
Press the
on the remote
control to answer
an incoming call.

Press the
key on the remote
control to terminate an ongoing
call.

Press the
key on the
remote control to
reject an incoming
call.
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Management systems booking list
If your video network makes use of the Cisco Telepresence Management System
(TMS), your video system may be set up for scheduled meetings from remote.
Typically, the TMS works with tools like Microsoft Outlook, permitting employees to
book and schedule video calls and conferences.
Any bookings applicable to your system will appear on the screen as shown in the
below example.
john.doe@videocompany.co.nla
Sept

20
TODAY’S BOOKINGS
NOW - 14:30

Align weekly

14:30 - 15:00

Sales meeting planning

15:00 - 15:30

Release planning
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Calling participants one by one
CALL

Provided that your video endpoint is equipped with the optional built-in Multisite
feature, any point-to-point video call (a call involving two parties only) may be
expanded to include additional participants. The call will then become a video
conference.

alice.wonderland@mycompany.com

During a call, open the Call menu again…

Enter contact...

Call

The
participant you
already are in
call with.

Settings Add another participant
CALL

Note that your video network may have an infrastructure permitting video
conferencing—even if your video system itself does not. This will require the presence
of an external Multipoint Control Unit (MCU).

alice.wonderland@mycompany.com

page 32 to
Systems equipped with Codec C20 have no Multisite feature (see
find out which type of codec your system has). However, all products described in this
user guide come with Multiway™ installed (see the next page for more on this).

HOME

542

Then call someone in the usual
manner—by dialing the number or URI
(in this case “542”) or by means of
the phone book. Invoke the virtual
keyboard (see “Entering text in text
fields” on page 8), if convenient.

The most advanced video systems (those using Codec C60 or C90) can—when
equipped with Multisite—set up video meetings with four participants (yourself
included). External MCUs may let you set up conferences with many more
participants.

Call

123

The next
participant
you are going
to call.

Call

Presentation
Phone book
Camera control
Recent calls
Settings Add another participant
CALL
alice.wonderland@mycompany.com

Finally, navigate down to
place the call…

Contact your system administrator for details on how to use external MCUs.

This example shows two entries made before any
calls are placed.

HOME

542

Call and

Call

If you want to add another participant
(you can call a maximum of three
participants), repeat the process.

Setting up a list of whom to call before calling them

After you have entered the participants, press
the
key to place the calls. Any of these may,
of course, be fetched from the phone book in the
usual manner.

123

Call

Camera control
Recent calls

Alternatively, you may set up a list of whom to call before you actually call them and
then call them all in one go (see the below example).

For units equipped with MultiSite capabilities, up to
three participants can be called simultaneously, if
no external MCUs are used.

HOME

Presentation
Phone book

Any ongoing video call can then be expanded to a video conference by adding more
participants at all times (see the right example).

To do this start by entering the first person to call
(directly, via the recent calls list or from the phone
book), then select Add another participant and add
a second person. When all have been entered,
press Call on the remote control or select the Call
icon in the menu.

Contact us

Call

Presentation
Phone book
Camera control
Recent calls

123

Use
this to place
the call.

Settings Add another participant

Terminating a video conference

CALL
alice.wonderland@mycompany.com
HOME
john.doe

abc

Call

The host of a video conference is the
endpoint to which all the others are
connected—the one who initiated the
conference.

Call

Presentation
Phone book
Camera control
Recent calls

The host has the right to terminate the
connection to any of the participants.
The participants cannot control any
of the others, but may disconnect
themselves from the meeting at all
times.

Settings Add another participant
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End call
Do you really want to disconnect this call?
Disconnect all
Disconnect alice.wonderland@mycompany.com
Disconnect 542
Cancel
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Using Multiway, Case 2
Someone calls you while you are in a call. You will need to decide whether the calling party
shall be invited to join the current call or not.

All systems described in this User guide offer Multiway as a means to call more
than one. Note that successful use of Multiway requires the presence of certain
infrastructure products. If in doubt check with your system administrator.

Someone calls you while you are in a call. A dialog box giving you three options will be
shown.

Incoming call
norah.dollhouse@somecompany.com
550092
Accept (put current call on hold)

Using Multiway, Case 1

Accept (disconnect current call)
Reject

Assume that you already are in a call and that you would like to expand the call to include
someone else.

Select Accept (put current call on hold).

Do as follows:

When you are ready to create the conference, select Join Calls.

Start calling someone else by pressing the

or the
HOME

Call

key on the remote control.
CALL
abc

Recent calls

alice.wonderland@everywhere.co.nl
Presentation
norah.dollhouse@somecompany.com

Camera control
Dorian Grey
Hedda Gabler
Settings
Floria Tosca

My contacts

Phone book

Call on hold
Your call with
james.dowe@somecompany.com
is on hold.

Enter the number or URI of the person to be included, either directly or by means of the
phone book or the list displayed) and place the call by pressing the key. This will put
the current call on Hold. When the new participant replies, select Join Calls.

Resume

Join calls

Hold

All three of you will now be in the same meeting.
Case 2 options: If you do not want to set up a Multiway conference, you have the following
choices in 2. above:
• If you want to accept the incoming call instead of the current call, select Accept
(disconnect current call).
• If you do not want to respond to the incoming call, select Reject.
Call on hold
Your call with
james.dowe@somecompany.com
is on hold.

Resume

Join calls

Hold

All three of you will now be in the same meeting.

The maximum number of participants in a Multiway call is limited by the capabilities of the
infrastructure of your network only. The two cases described on this page may be combined
as much as you want.

Repeat to include more participants if needed.
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Which codec does my system have?
At any rate, MultiSite is an optional feature that may—or may not—be present in your
endpoint.

The optional ability to call more than one participant—the MultiSite feature— does
not apply to all video endpoints. This depends on the type of codec your system is
equipped with. The following applies:

If you need to see which type of codec your system is equipped with, open the
bottom module lid of the system.

• Endpoints using Codec C40, C60 and C90 support MultiSite and MultiWay.
• Endpoints using Codec C20 do not support MultiSite, but MultiWay.
• Quick Set C20 / C20 Plus both use the Codec C20. Consequently, they do not
support MultiSite, but MultiWay.

Looking for codec type:

Profile series codecs:

Codec C90

Open the bottom module lid as
shown, to see which type of
codec you have.

Codec C60

Codec C40

Codec C20
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Opening the phone book

Your video system contains a phone book. The phone book is organized in a way very
similar to what you find in a mobile phone.
It contains a section where you can add your own list of contacts, and most corporate
solutions will also include a corporate phone list.
This corporate phone list is normally installed and maintained from remote by your
system administrator through a management system like the Cisco Telepresence
Management Suite (TMS), which is available separately.

Press the

key…

You cannot edit the corporate list yourself, but you may add entries to My Contacts.
These may be edited as much as you want.

... the Phone book menu will now open…

Navigating in the phone book
Navigate in the phone book with the
Arrow and keys.
The phone book may contain folders
indicated by folder icons ( ). Press
the Arrow key to display the
contents of a folder. Repeat, if needed,
if there are more folder levels.
Whenever you are at a lower level, use
the Arrow key to move one level
back.

PHONE BOOK

Folders contain
phone book
entries (and they
may even contain
subfolders).

PHONE BOOK
Search
My contacts
0.1 - Beijing Office
0.2 - London Office

Search
My contacts
0.1 - Beijing Office
0.2 - London Office

0.3 - New York Office

0.3 - New York Office

0.4 - Oslo Office
0.5 - San Jose Office

0.4 - Oslo Office

0.5 - Washington Office

0.5 - San Jose Office
0.5 - Washington Office

Searching for an entry is explained on
the next page.

The phone book typically contains your own My contacts and a corporate phone book.
You may create your own list of contacts in My contacts.

Calling an entry in the phone book

CALL

The phone book can
also be accessed
from the Call menu.

PHONE BOOK

When an entry is located, just press
key to place the call.
the

Search

a

Abraham Anderson
Adrian Jones

Phone book

Harry P. Otter
Hedda Gabler

Recent calls

Norah Dollhouse
Peer A. Gynt

Add another participant

Roberta Nielsen
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How to search for an entry

The My contacts may contain up to 200 entries, but the entire phone book can be
virtually unlimited in size. Consequently, using the arrow keys as the only navigation
device can easily mean a lot of work. What to do?

PHONE BOOK

Press the
key to display
the Phone book. This will also
invoke the virtual keyboard.

Search

Enter the search function. By means of a virtual keyboard the search procedure is a
simple and convenient way of locating an entry.

My contacts
0.1 - Beijing Office
0.2 - London Office

Your phone book may contain folders, as outlined.

0.3 - New York Office
0.4 - Oslo Office

Searches made will include current folder and any subfolders, so if you stay at the top
level (sometimes referred to as the root level), your search will be made within all the
(sub)folders.

0.5 - San Jose Office
0.5 - Washington Office

PHONE BOOK
Search
My contacts
0.1 - Beijing Office
0.2 - London Office
0.3 - New York Office
0.4 - Oslo Office

Use the
Arrow key as
shown to move the cursor
up into the virtual keyboard
(indicated by an orange
square).

0.5 - San Jose Office
0.5 - Washington Office

PHONE BOOK
Search

a

Abraham Anderson
Adrian Jones
Harry P. Otter
Hedda Gabler
Norah Dollhouse
Peer A. Gynt
Roberta Nielsen

Use the Arrow keys to move
about the keyboard and the
key to select a character.
Access special characters
and numerics by means of the
corresponding keys.
Matches will appear as you
write, as outlined.
How to call the selected
entry is shown in the section
“Making calls”.

Add more letters to narrow and refine your search.
Example: Keying in da, will return entries like Dave Olson and David Jones, but also John
Dahl and Vittorio Dalmazzino. There is no case sensitivity.
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Adding an entry manually to My contacts
Open the phone book by pressing the
navigate to My contacts:

New contacts can be added to My contacts only. Other entries must be entered by
your system administrator.

key on the remote control and
PHONE BOOK

Search
My contacts
0.1 - Beijing Office
0.2 - London Office
0.3 - New York Office

Adding an entry from recent calls or the phone book

0.4 - Oslo Office
0.5 - San Jose Office
0.5 - Washington Office

While you are inside the phone book or inside the list of recent calls, navigate to the entry
you would like to copy to My contacts and press the key or the Arrow key to show the
Options menu:
RECENT CALLS
harry.p.otter@somecompany.com

Press the

MY CONTACTS

Harry P. Otter

harry.p.otter@somecompany.com

Search My contacts

Received 20.06.11 16.29

hedda.gabler@somecompany.org
Placed 20.06.11 15.10

dorian.grey@myself.net
Missed 20.06.11 14.55

frodo,b.aggins@myshire.org
Received 20.06.11 12.20

floria.tosca@somecompany.org
Placed 20.06.11 08.17

key to show the contents of My contacts:

abc

Call
Edit before call

Add new contact

Save to my contacts

10.47.148.797

Add to participants list

Adrian Jones

View dialing method

Alice Wonderland
Hedda Gabler
Norah Dollhouse

Navigate to Add new contact and press the

SAVE TO MY CONTACTS
Name

Harry P. Otter

NEW CONTACT

abc

Number / URI H323:harry.p.otter

Shown
ghosted
because
nothing
has been
entered yet.

Save
Cancel

Navigate down to Save to my contacts and press the
you to edit the entry, if needed.

key to open the dialog box that allows

All contents are copyright © 2010–2011 Cisco Systems, Inc. All rights reserved.

Name

Abc

Number / URI
Save
Cancel

Enter name and number (URI) of the new contact. After you have entered this
information, the Save field will no longer appear ghosted and you may navigate
down to this field and press the key to save your new entry.

This is similar to entering a new contact manually (see right for details), but in this case the
name and number or URI of the copied contact has already been filled in for you by the
system. If you want to edit the information entered, you may do so. Remember to save before
leaving the menu.
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Alternatively, navigate down to Cancel and press the
without saving the new entry.
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Editing existing entries in the phone book
You may edit and delete entries in My contacts any time. Since updates in the
corporate phone book(s) made by your system administrator will fail to affect My
contacts, you may have to use this feature from time to time if corporate phone book
changes are made.

Editing entries in the phone book
PHONE BOOK

MY CONTACTS

Search

Search My contacts

My contacts

abc

Add new contact

0.1 - Beijing Office

10.47.148.797

0.2 - London Office

Adrian Jones

0.3 - New York Office

Alice Wonderland

0.4 - Oslo Office

Hedda Gabler

0.5 - San Jose Office

Norah Dollhouse

0.5 - Washington Office

Navigate to the entry to be edited
and press the key.

Open the phone book by pressing the
key
and and then navigate to My contacts. Press
the key to open My contacts.
You may call the entry directly.
hedda.gabler@somecompany.com
hedda.gabler@somecompany.com

Call
Edit before call
Add to participant list
View dialing methods
Remove from list
Edit contact details

You may edit the number or URI.
You may add the entry to participants list when setting up a
conference.
If the entry is listed with more dialing methods than the default, you
may use this to, for example use H.323 instead default SIP (or the
other way around).

EDIT CONTACTS

You may remove the entry from the list.

Name

You may edit contact details.

Number / URI hedda.gabler@some

Hedda Gabler

abc

Save
Cancel
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Sharing PC contents
Make sure the PC does not cover any of the microphones.
This will reduce the perceived audio quality at the far end.

General recommendations tips for making your video meeting room as good as
possible are described in the Administrator guide for this product. The Administrator
guide may be downloaded from www.cisco.com/go/telepresence/docs.

Locate the DVI cable and connect the PC to the video system.
Connect the audio mini-jack output from the PC, or any other
source—including Ipod—to the mini-jack socket of the cable to
get sound. Connect the RCA connectors to the corresponding
sockets on the codec/endpoint.

Dual video stream
With dual video stream you can view two different live video streams simultaneously—
the main video and one additional source. This could for example be both a PC
(presentation and the person who gives the presentation.

When pressing the Presentation button (
)on the remote
control the default presentation source is activated.
The DVI / VGA input is compliant with VESA Extended Display
Identification Data (EDID) and will be able to notify the PC of the
supported output formats.

If a video system does not support dual video stream, no second video stream will be
established for this system and the PC presentation will be shown as the main video.

If the shared contents fail to show
• Normally you must press a special key combination to switch the PC image from the PC
screen to the video screen.
• Check that the presentation source is correctly defined. Access to this setting may be
password protected by your system administrator. The procedure is described in the
Administrator guide for this product.
• Make sure your PC is set to activate your VGA output.

Selecting the source
To specify which source to serve as presentation source select it as shown here. Note that
the name of each source can be changed, consult your administrator for details on this. All
the options are not available to all systems.
HOME
PRESENTATION

HOME
Call
Presentation
Camera control
Settings
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Call

Secondary camera (no signal)

PC
Presentation
DVD
Camera control
Document camera
Settings No presentation
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Controlling the cameras
During a call, you may control where your own camera is pointing (i.e. pan and tilt)
and the zoom. However, far end systems with remotely controllable cameras may
also permit you to control their camera’s panning and zooming. This is called Far end
camera control.

For video conferences with more than two participants, far end is an ambiguous term.
If you are the initiator of a conference the only far end camera controllable by you will
be the first participant you called. The other participants may all control your camera,
but they cannot control each other.

Controlling your own camera (near side)

Controlling far end camera (far side)

In a call use the Arrow keys of the remote control to enter the camera
control mode. Softbuttons will now appear as shown below.

In a call use the Arrow keys of the remote control to enter the camera
control mode. Softbuttons will now appear as shown below.

Use the Arrow keys and the Zoom keys to pan, tilt and zoom your
camera.

Proceed as for near end camera control.

Press the leftmost Function key to access the far end camera.

Exit the mode when finished.

Access to far
end camera (if
far end camera
is remotely
controllable).

Access to your
own camera
presets, if
defined.

Access to your
own camera’s
settings.

Access to your
own system’s
main source
setting.

Exit this
mode.
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Exit this
mode.
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Administrator settings & password
The Advanced configuration settings are aimed at system administrators only and may
have been password protected by your system administrator. Unless you are the system
administrator you should normally leave these settings as they are.

The Administrator settings lets you define extra softbutton functions; change the IP
settings of the system; use the advanced configuration options and change the menu
access password.

The IP settings (not shown) are also aimed at system administrators.
The Advanced configuration settings and the IP settings are described in the Administrator
Guide applying to your video system. This guide can be downloaded from www.cisco.com/
go/telepresence/docs.

Your video system can be configured through its web interface, but it may also be
configured through the Advanced configuration. This is all normally done by your
system administrator, who may have password protected the access to the Advanced
configuration.

The password may not have been set. If you decide to give your system a password, take
care. If you forget your password contact your Cisco representative for help.

Entering the Administrator settings

SETTINGS
HOME
Call
Presentation
Camera control
Settings

Starting from the Home menu,
navigate down to Settings and
press the key.

Layout

Layout

Main source: Camera

Main source: Camera

Call settings

Call settings

Language: English
Date and time

Language: English
HOME

Sounds and alerts
Call
Wallpaper: Growing
Presentation
System information
Camera control
Administrator settings
Settings
Restart

Then navigate to Administrator settings
and press the key again to display the
options available.
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Date and time

HOME

PASSWORD
SoundsADMINISTRATOR
and alerts
Call
Please enter your
Wallpaper: Growing
Administrator password:
Presentation

System
*** information
Camera control
Advanced
OK
Settings
Restart
Cancel

Enter the password. Invoke the virtual keyboard, if
needed and navigate to OK to enter the settings
menu.
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Assigning softbutton functions
The Function keys of the system’s remote control are used to control the softbuttons
appearing along the lower end of the screen—see also
”Navigating in the menus”
on page 7 for more.

The softbuttons are context sensitive, which means that they appear only when
needed and not else. You may enhance your system’s perceived performance by
assigning your own functionalities to the softbuttons.

!

Assigning a function to a softbutton

The description presented on this page
assumes that you are already inside the
Administrator settings, as described on the
previous page.

SETTINGS

SETTINGS
Layout

Layout

Main source: Camera

Main source: Camera

Call settings

Call settings

Language: English ADMINISTRATOR SETTINGS

Language: English ADMINISTRATOR SETTINGS

HOME
Date
and time
Programmable
softbuttons

HOME
Date
and time
Programmable
softbuttons

Sounds and alerts
Call Audio input levels

Sounds and alerts
Call Audio input levels

Wallpaper:
Growing
Connect to
Cisco Callway
Presentation
System
information
IP settings

Wallpaper:
Growing
Connect to
Callway
Presentation
System
information
IP settings
Camera control SYSTEM MODE
Advanced
Advanced configuration
In idle
Settings
Restart
Change password
In call

Camera control
Advanced
Set menu password
Settings
Restart
Pairing

If you want a softbutton assignment to apply
to both idle and in-call situations, you must
assign a function twice.

Advanced configuration

Navigate to Programmable softbuttons, as outlined, and
press the key. Se also the previous page, if needed.

Navigate to select whether the softbutton function shall
apply to idle or to in-call conditions—see below. Press the
key.

SETTINGS

SETTINGS

Layout

Layout

Main source: Camera

Main source: Camera

Call settings

Call settings

Language: English ADMINISTRATOR SETTINGS

Language: English ADMINISTRATOR SETTINGS

HOME
Date
and time
Programmable
softbuttons

HOME
Date
and time
Programmable
softbuttons

IN CALL

Sounds and alerts
levels
Call Audio input
Softbutton 1: Not set
Wallpaper:
Growing
Connect to
Callway
Presentation Softbutton 2: Not set
System
information
IP settings
Softbutton 3: Not set
Camera control SYSTEM MODE
Advanced
Advanced configuration
In idle Softbutton 4: Not set
Settings
Restart
Change password
In call Softbutton 5: Not set

Navigate to select which softbutton to assign a function
to. Press the key.
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There must be one setting for idle and
another one for in-call mode.
Note that any softbutton may be assigned to
any of the functions available.
Consequently, setting one softbutton to a
specific function for idle situations does
not require that the same function must be
assigned to the same softbutton for in-call
situations.
However, doing so may appear more logical in
many cases.

IN CALL

Sounds and alerts
levels
Call Audio input
Softbutton 1: Not set
Wallpaper:
Growing
Connect to
Callway
Presentation Softbutton 2: Not set
System
information
IP settings
Main source
Softbutton
3: Notselection
set
Camera control SYSTEM MODE
Advanced
Advanced configuration
Camera preset
In idle Softbutton 4: Not set
Settings
Restart
Change password
Speed dials
In call Softbutton 5: Not set

SOFTBUTTON 1

Select among the options available and press the
key. The
options are presented in detail on the following pages.

43

!
The access to the settings described here,
may have been password protected by your
system administrator. Contact your system
administrator, if in doubt.
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Creating softbutton for Main source selection

Creating softbutton for Camera Preset

If you want direct access (via the softbuttons along the bottom line of the screen) to
the source used, you should assign the function Main source selection to one of the
softbuttons. In the following we will use Softbutton 1 as an example, but the function
may, of course, be assigned to any of the five softbuttons.

If you want direct access (via the softbuttons along the bottom line of the screen) to
predefined camera presets, you should assign the function Camera preset to one or
more of the softbuttons.
Note that camera presets must have been defined before you start assigning presets
“Camera
����������������������������������������
presets” on page 10 for more on
to any of the softbuttons—see
camera presets.
The below illustration uses Softbutton 4 as an example, but the function may, of
course, be assigned to any of the five softbuttons.

!
How to get to the menus shown below
left and below right is described on
the previous page.

If you have set Softbutton 1 to PC as main
source, you may want to set Softbutton 2 to
Camera (or the other way around) in order to
be able to conveniently switch between the
two.

Assigning Main source selection softbutton

Assigning Camera preset softbutton

SETTINGS
Layout
Main source: Camera

SETTINGS

Call settings

Layout

Language: English ADMINISTRATOR SETTINGS
HOME
Date
and time
Programmable
softbuttons

Main source: Camera

IN CALL

Call settings

Sounds and alerts
levels
Call Audio input
Softbutton 1: Not set
Wallpaper:
Growing
Connect to
Callway
Presentation Softbutton 2: Not set
System
information
IP settings
Main source
Softbutton
3: Notselection
set
Camera control SYSTEM MODE
Advanced
Advanced configuration
Camera preset
In idle Softbutton 4: Not set
Settings
Restart
Change password
Speed dials
In call Softbutton 5: Not set

Language: English ADMINISTRATOR SETTINGS
SOFTBUTTON 1

HOME
Date
and time
Programmable
softbuttons

MAIN SOURCE SELECTION

Sounds and alerts
levels
Call Audio input
Softbutton 1: Not set

Camera

Wallpaper:
Growing
Connect to
Callway
2: Not set
Presentation Softbutton
Main source selection
System
information
IP settings
Softbutton
3: MODE
Not set
SYSTEM
Camera
preset
Camera control
Advanced
Advanced configuration
4: Not set
In idle Softbutton
Speed dials
Settings
Restart
Change password
5: Not set
In call Softbutton
Clear softbutton

PC

The number of sources
available will depend on
your system.
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IN CALL
SOFTBUTTON 4
CAMERA PRESET SELECTION
Pos. 1
Zoom out
Whiteboard

www.cisco.com

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20
Contents

Getting started

Making calls

Phone book usage

User guide

In-call features

Advanced settings
settings
Advanced

Contact us

Softbutton—Speed dials

Customized softbuttons—how they appear

If you want direct access (via the softbuttons along the bottom line of the screen) to
contacts in the phone book, you should assign the function Speed dials to one or more
of the softbuttons.

The below illustration shows how the video system screen may look with five
customized softbuttons added.

Note that assignments can be made to existing contacts only (My contacts as well as
��������
36.
the corporate phone book). To add a contact to your list of contacts, see page
In the following we will use Softbutton 5 as an example, but the function may, of
course, be assigned to any of the five softbuttons.

!
How to get to the menu shown below is described two pages back.

Assigning Camera preset softbutton

Example of customized softbuttons
Sept

20

SETTINGS
Layout

PHONE BOOK

Main source: Camera
Call settings

Search

Language: English ADMINISTRATOR SETTINGS
HOME
Date
and time
Programmable
softbuttons

Sounds and alerts
levels
Call Audio input
Softbutton 1: Not set
Wallpaper:
Growing
Connect to
Callway
2: Not set
Presentation Softbutton
Main source selection
System
information
IP settings
Softbutton
3: MODE
Not set
SYSTEM
Camera control Camera preset
Advanced
Advanced configuration
4: Not set
In idle Softbutton
Speed dials
Settings
Restart
Change password
5: Not set
In call Softbutton
Clear softbutton

IN CALL

My contacts
0.1 - Beijing Office

SOFTBUTTON 5

0.2 - London Office
0.3 - New York Office
0.4 - Oslo Office
0.5 - San Jose Office
0.5 - Washington Office
Camera
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PC

Zoom in

Zoom out

Norah Dollhouse
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Softbutton—Clear softbuttons
You may clear softbuttons that you no longer want to appear. This is done via the
Clear softbutton at the bottom of the menu. You do not have to clear a softbutton
function before assign the same softbutton to another function. That may be done
right away.
For more on how to get to the below menu—see

Make sure you select the right softbutton (idle mode or in-call mode).

page
��������������������
43 for details.

SETTINGS
Layout
Main source: Camera
Call settings
Language: English ADMINISTRATOR SETTINGS
HOME
Date
and time
Programmable
softbuttons

IN CALL

Sounds and alerts
levels
Call Audio input
Softbutton 1: Not set
Wallpaper:
Growing
Connect to
Callway
Presentation Softbutton 2: Not set
System
information
IP settings
Main source
Softbutton
3: Notselection
set
Camera control SYSTEM MODE
Advanced
Advanced configuration
Camera preset
In idle Softbutton 4: Not set
Settings
Restart
Change password
Speed dials
In call Softbutton 5: Not set

SOFTBUTTON 1

Clear softbutton
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THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS
IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL
STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL
ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL
RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.
THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE
ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET
THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY
THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE
OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A
COPY.
The Cisco implementation of TCP header compression is an adaptation of a
program developed by the University of California, Berkeley (UCB) as part of
UCB’s public domain version of the UNIX operating system. All rights reserved.
Copyright © 1981, Regents of the University of California.
NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT
FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH
ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION,
THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR
TRADE PRACTICE.

On our web site you will find an overview of the worldwide Cisco
contacts.
Go to: http://www.cisco.com/web/siteassets/contacts/index.html

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY
INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES,
INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO
DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN
IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

Corporate Headquarters
Ciso Systems, Inc.
170 West Tasman Dr.
San Jose, CA 95134 USA

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its
affiliates in the U.S. and other countries. A listing of Cisco’s trademarks can
be found at www.cisco.com/go/trademarks. Third party trademarks mentioned
are the property of their respective owners. The use of the word partner does
not imply a partnership relationship between Cisco and any other company.
(1005R)
Any Internet Protocol (IP) addresses and phone numbers used in this document
are not intended to be actual addresses and phone numbers. Any examples,
command display output, network topology diagrams, and other figures
included in the document are shown for illustrative purposes only. Any use of
actual IP addresses or phone numbers in illustrative content is unintentional and
coincidental.
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